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RZ/N2L グループ 
ローダプログラムとアプリケーションプログラムのプロジェクト分割例 

要旨 
本アプリケーションノートでは、ローダプログラムとアプリケーションプログラムのプロジェクトを分割

したサンプルプログラムについて説明します。 

 

本サンプルプログラムの特徴を以下に示します。 

• 本サンプルプログラムは xSPI0 ブートモード (x1 ブートシリアルフラッシュ)版、16 ビットバス

ブートモード (NOR フラッシュ)版の 2 つの動作モードに対応しています。 

• 本サンプルプログラムにはローダプログラムとアプリケーションプログラムの 2 つのサンプルプログ

ラムがあり、それぞれのプロジェクトに分割されています。 

• ローダプログラムはアプリケーションプログラムを外付けフラッシュから内蔵 RAM や外部 RAM へ

コピーするためのプログラムです。ローダプログラム内に定義されているローダテーブルの情報(コ
ピー元アドレス、コピー先アドレス、サイズ)に従ってアプリケーションプログラムのコピー処理を

行います。 

• アプリケーションプログラムはローダプログラムでコピーされるサンプルプログラムです。ローダプ

ログラム終了後に動作し、本デバイスに必要な初期設定を行い、LED の点滅処理を行います。 

 

動作確認デバイス 
RZ/N2L グループ 
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1. 仕様 

1.1 動作環境 
本アプリケーションノートのサンプルプログラムは、下記の環境を想定しています。 

 

表 1.1 動作環境 

項目 内容 
使用マイコン RZ/N2L グループ (R9A07G084M04GBG) 
動作周波数 CPU : 400MHz (ArmⓇ CortexⓇ-R52) 
動作電圧 3.3V / 1.8V / 1.1V 
統合開発環境 • IAR システムズ製 

Embedded Workbench® for Arm Version 9.60.3 
• Renesas 製 

e2 studio 2025-04.1 (25.4.1) (R20250508-1327) 
動作モード • xSPI0 ブートモード(x1 シリアルフラッシュ) 

• 16 ビットバスブートモード(NOR フラッシュ) 
使用ボード Renesas Starter Kit+ for RZ/N2L 
Flexible Software Package (FSP) Version 3.0.0(For RZ/N series) 
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1.2 ファイル構成 
本パッケージのファイル構成と内容物の詳細を下記に示します。 

    RZN2L_loader_application 

    ├─r01an6737jj0301-rzn2l-separating-loader-and-application.pdf 

    ├─r01an6737ej0301-rzn2l-separating-loader-and-application.pdf 

    ├─iccarm : EWARM 環境用 

    │  ├─16bitbusboot :16 ビットバスブートモード(NOR フラッシュメモリ)用サンプルプログラム 

    │  │  └─Loader_application_projects.zip 

    │  │    ├─RZN2L_bsp_16bitbusboot_app : アプリケーションプログラム用プロジェクト 

    │  │    ├─RZN2L_bsp_16bitbusboot_loader : ローダプログラム用プロジェクト 

    │  │    └─RZN2L_bsp_16bitbusboot_separating_loader.eww : EWARM ワークスペース 

    │  └─xspi0bootx1 : xSPI0 ブートモード(x1 フラッシュメモリ)用サンプルプログラム 

    │      └─Loader_application_projects.zip 

    │        ├─RZN2L_bsp_xspi0bootx1_app : アプリケーションプログラム用プロジェクト 

    │        ├─RZN2L_bsp_xspi0bootx1_loader : ローダプログラム用プロジェクト 

    │        └─RZN2L_bsp_xspi0bootx1_separating_loader.eww : EWARM ワークスペース 

    └─gcc : e2 studio 環境用 

        ├─16bitbusboot : 16 ビットバスブートモード(NOR フラッシュメモリ)用サンプルプログラム 

        │  └─Loader_application_projects.zip 

        │    ├─RZN2L_bsp_16bitbusboot_app : アプリケーションプログラム用プロジェクト 

        │    └─RZN2L_bsp_16bitbusboot_loader : ローダプログラム用プロジェクト 

        └─xspi0bootx1 : xSPI0 ブートモード(x1 フラッシュメモリ)用サンプルプログラム 

            └─Loader_application_projects.zip 

              ├─RZN2L_bsp_xspi0bootx1_app : アプリケーションプログラム用プロジェクト 

              └─RZN2L_bsp_xspi0bootx1_loader : ローダプログラム用プロジェクト 

 

本サンプルプログラムのパッケージは EWARM と e² studio 環境で準備されており、それぞれの環境で

16 ビットバスブートモード(NOR フラッシュメモリ)用と xSPI0 ブートモード(x1 フラッシュメモリ)用の

サンプルプログラムがあります。本サンプルプログラムはローダプログラムのプロジェクトとアプリ

ケーションプログラムのプロジェクトで構成されています。 
 

各開発環境におけるサンプルプログラムの使用方法については、付録. 各開発環境における補足内容を

参照してください。 
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1.3 ボードのスイッチ/ジャンパ設定 
本サンプルプログラムを動作させるために必要なスイッチ/ジャンパ設定を下記に示します。各設定の詳細

につきましては、Renesas Starter Kit+ for RZ/N2L ユーザーズマニュアルを参照してください。 

 

表 1.2 スイッチの設定 

プロジェクト SW4-1 SW4-2 SW4-3 SW4-4 SW4-7 
16 ビットバスブートモード版 ON OFF ON ON OFF 
xSPI0 ブートモード版 ON ON ON ON OFF 

 

表 1.3 ジャンパの設定 

プロジェクト CN8 CN17 CN24 CN25 CN27 
16 ビットバスブートモード版 - Short 1-2 Short 1-2 Short 1-2 - 
xSPI0 ブートモード版 Short 2-3 - Short 2-3 - Short 2-3 
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2. ハードウェア説明 

2.1 使用周辺機能 
下記に本サンプルプログラムで使用する周辺機能と用途を示します。 

 

表 2.1 使用する周辺機能と用途 

項目 内容 
クロック発生回路(CGC) CPU クロックおよび各周辺モジュールクロックで

使用 
割り込みコントローラ(ICU) ソフトウェア割り込み(INTCPU0)で使用 
バスステートコントローラ(BSC) CS0 空間に NOR フラッシュメモリを接続、およ

び、CS3 空間に SDRAM を接続するために使用 
拡張シリアルペリフェラルインタフェース(xSPI) 外部アドレス空間 xSPI0 にシリアルフラッシュメモ

リを接続するために使用 
汎用入出力ポート LED の点灯および消灯のための端子制御に使用 

 
 
各周辺機能についての基本的な内容は、RZ/N2L グループ・ユーザーズマニュアル ハードウェア編を参照

してください。 
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2.2 使用端子一覧 
表 2.2 に使用端子と機能を示します。 

 

表 2.2 使用端子と機能 

端子名 入出力 内容 
A1 ~ A25 出力 NOR フラッシュメモリ、SDRAM へのアドレス信号出力 
D0 ~ D15 入出力 NOR フラッシュメモリ、SDRAM のデータ信号入出力 
CS0# 出力 CS0 空間に接続された NOR フラッシュメモリへのデバイス選択信号出力 
CS3# 出力 CS3 空間に接続された SDRAM へのデバイス選択信号出力 
RAS# 出力 SDRAM への RAS#制御信号出力 
CAS# 出力 SDRAM への CAS#制御信号出力 
RD/WR# 出力 SDRAM へのリード制御信号またはライト制御信号出力 
CKE 出力 SDRAM へのクロックイネーブル制御信号出力 
RD# 出力 リード中を示すストローブ信号出力 
WE0#/DQMLL 出力 D15 ~ D8 に対するライトストローブ信号出力 
WE1#/DQMLU 出力 D7 ~ D0 に対するライトストローブ信号出力 
XSPI0_CKP 出力 クロック出力 
XSPI0_CS0 出力 CS0 空間に接続された QSPI フラッシュメモリへのデバイス選択信号出力 
XSPI0_RESET0 出力 マスタリセットステータス出力 
XSPI0_IO0 ~ 
XSPI0_IO3 

入出力 データ入出力 

MD0 入力 動作モードの選択入力 
• MD0 = “L”, MD1 = “L”, MD2 = “L” (xSPI0 ブートモード) 
• MD0 = “L”, MD1 = “H”, MD2 = “L” (16 ビットバスブートモード) 

MD1 入力 
MD2 入力 
P18_2 出力 LED0 の点灯および消灯 
P22_3 出力 LED1 の点灯および消灯 
P04_1 出力 LED2 の点灯および消灯 
P17_3 出力 LED3 の点灯および消灯 

【注】 #は負論理(またはアクティブロー)を示す記号です。 
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3. ソフトウェア説明 
以降、特に明記しない場合は EWARM(IAR システムズ社製)と e2 studio で共通の説明になります。 

本書ではローダプロジェクトに含まれるプログラムをローダプログラム、アプリケーションプロジェクト

に含まれるプログラムをアプリケーションプログラムと呼びます。また、各ローダ/アプリケーションプロ

グラムはスタートアップ処理部とメイン処理部に分かれています。 

3.1 動作概要 
本デバイスは、リセット解除後のブート処理で、各動作モード(16 ビットバスブート/xSPI0 ブート)に対応

する外付けフラッシュ(NOR フラッシュ/シリアルフラッシュ)メモリに格納されたローダプログラムを

BTCM へコピーします。 

ブート処理後、BTCM にコピーしたローダプログラムを実行します。ローダプログラムはアプリケーショ

ンプログラムを外付けフラッシュ(NOR フラッシュ/シリアルフラッシュ)メモリから内蔵 RAM(System 
SRAM)へコピーします。ローダプログラム終了後、コピーされたアプリケーションプログラムが RAM 上で

動作します。 

 

図 3.1 動作概要 
 

  

Storage area 

Loader program 

Application program 

Execution area 

1 

2 

1. After reset release, copy the loader program from external flash memory to 
BTCM in boot processing. 
2. Copy the application program from external flash memory to System SRAM in 
loader program processing. 
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3.1.1 ローダプログラム 
ローダプログラムではスタートアップ処理として、Exception Level の変更、クロック設定などの初期

設定を行います。その後、メイン処理が実行されます。メイン処理ではローダテーブルのパラメータに

従って、外付けフラッシュ(NOR フラッシュ/シリアルフラッシュ)メモリに格納されたアプリケーション

プログラムを System SRAM へコピーします。ローダテーブルはローダプログラムがアプリケーション

プログラムをコピーする際に参照するテーブルです。ローダテーブルの詳細につきましては、「3.2 
ローダテーブル」を参照してください。 

また、コピー処理開始の合図として LED0 が点灯しコピー処理終了の合図として LED3 が点灯しま

す。コピー処理終了後はアプリケーションプログラムを実行します。 
ローダプログラムの動作概要を図 3.2 に示します。 
 

図 3.2  ローダプログラムの動作概要 
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3.1.2 アプリケーションプログラム 
アプリケーションプログラムではスタートアップ処理として、クロック設定、ポート初期設定、割り

込み設定などの初期設定を行います。ローダプログラム処理時に点灯した LED0 と LED3 はポート設定

時に消灯します。その後、メイン処理部が実行されます。 
 
メイン処理は System SRAM 上で LED の点滅処理が実行されます。LED の点滅処理はソフトウェア割

り込み(INTCPU0)によって処理され、LED0 と LED3 が点滅します。 
 
アプリケーションプログラムの動作概要を図 3.3 に示します。 
 

図 3.3  アプリケーションプログラムの動作概要 
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3.2 ローダテーブル 
ローダテーブルはローダプログラムがアプリケーションプログラムをコピーする際に参照するテーブルで

す。ローダテーブルにはプログラムのコピーに必要なパラメータが定義されており、ローダプログラムは

テーブルのパラメータに従ってコピー処理を行います。ローダテーブルは必要に応じて複数準備することが

可能で、各テーブルにパラメータを保持できます。 

ローダテーブルにはコピー元アドレス、コピー先アドレス、コピーサイズ、テーブル有効/無効フラグの 4
つのパラメータがあります。ローダテーブルのパラメータの詳細を表 3.1 に示します。 

本サンプルプログラムではローダプログラムの loader_table.c に 4 つのローダテーブルが準備されていま

す。使用する動作モードに応じてコピー元のアドレスが変わります。本サンプルプログラムにおけるローダ

テーブルのパラメータを表 3.2、表 3.3 に示します。 

 

表 3.1 ローダテーブルのパラメータ 

引数 パラメータ 説明 
1 Src コピーするプログラムのコピー元アドレス。 
2 Dst コピーするプログラムのコピー先アドレス。 
3 Size コピーするプログラムのサイズ。 
4 Enable flag テーブルの有効/無効を決定するフラグ。 

本フラグが無効の場合、他のパラメータを設定してもコピー処理が行われませ

ん。 
0 : Disable 
1 : Enable 

 
 

表 3.2 本サンプルプログラムにおけるローダテーブルのパラメータ(xSPI0 ブートモード版) 

テーブル Src Dst Size Enable flag 
0 0x6010_0000 0x1001_0000 0x0000_2000 0x1 
1 注 0xFFFF_FFFF 0xFFFF_FFFF 0xFFFF_FFFF  0x0 
2 注 0xFFFF_FFFF 0xFFFF_FFFF 0xFFFF_FFFF  0x0 
3 注 0xFFFF_FFFF 0xFFFF_FFFF 0xFFFF_FFFF 0x0 

【注】 本サンプルプログラムにおいて、テーブル 1,2,3 は無効です。ユーザが自由に変更可能です。 
 

 
表 3.3 本サンプルプログラムにおけるローダテーブルのパラメータ(16 ビットバスブートモード版) 

テーブル Src Dst Size Enable flag 
0 0x7010_0000 0x1001_0000 0x0000_2000 0x1 
1 注 0xFFFF_FFFF 0xFFFF_FFFF 0xFFFF_FFFF 0x0 
2 注 0xFFFF_FFFF 0xFFFF_FFFF 0xFFFF_FFFF 0x0 
3 注 0xFFFF_FFFF 0xFFFF_FFFF 0xFFFF_FFFF 0x0 

【注】 本サンプルプログラムにおいて、テーブル 1,2,3 は無効です。ユーザが自由に変更可能です。 
 
 
 

 

 

 
  



RZ/N2L グループ ローダプログラムとアプリケーションプログラムのプロジェクト分割例 

R01AN6737JJ0301  Rev.3.01  Page 13 of 47 
2026.4.1  

3.3 メモリマップ 
3.3.1 フラッシュメモリのプログラム配置 

表 3.4、表 3.5 に本サンプルプログラムのフラッシュメモリに配置されるプログラムを示します。使用

する動作モードに応じてフラッシュメモリのアドレスが変わります。デバッグ接続時、プログラムはフ

ラッシュメモリへダウンロードされます。各プログラムはブート処理やローダプログラムによってロー

ド先アドレスに展開され、RAM 上で実行されます。 
 

表 3.4 フラッシュメモリのプログラム配置とロード先アドレス(xSPI0 ブートモード版) 

フラッシュメモリアドレス 内容物 ロード先アドレス 
0x6000_0000 ローダ用パラメータ - 
0x6000_004C ローダプログラム 0x0010_2000 (BTCM) 
0x6008_0000 ローダテーブル - 
0x6010_0000 アプリケーションプログラム 0x1001_0000 (System SRAM) 

  
 

表 3.5 フラッシュメモリのプログラム配置とロード先アドレス(16 ビットバスブートモード版) 

フラッシュメモリアドレス 内容物 ロード先アドレス 
0x7000_0000 ローダ用パラメータ - 
0x7000_004C ローダプログラム 0x0010_2000 (BTCM) 
0x7008_0000 ローダテーブル - 
0x7010_0000 アプリケーションプログラム 0x1001_0000 (System SRAM) 
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3.3.2 サンプルプログラムにおける各セクション配置 
3.3.2.1 EWARM 

表 3.6 にローダプログラムで使用するセクション、表 3.7 にアプリケーションプログラムで使用する

セクションを示します。これらのセクションはリンカスクリプトで定義されています。 
 

表 3.6 ローダプログラムで使用するセクション 

セクション/ブロックの 
名前 

内容 格納/実行 
領域注 1 

LOADER_PARAM_BLOCK ローダパラメータ Flash 
PRG_RBLOCK コード領域(格納用) Flash 
USER_DATA_RBLOCK 変数領域(格納用) Flash 
PRG_WBLOCK コード領域(実行用) BTCM 
USER_DATA_WBLOCK 初期値あり変数領域(実行用) BTCM 
USER_DATA_ZBLOCK 初期値なし変数領域(実行用) BTCM 
APPLICATION_PRG_RBLOCK アプリケーションプログラム領域(格納用) Flash 
APPLICATION_PRG_WBLOCK アプリケーションプログラム領域(実行用) System SRAM 

【注】 1. xSPI0 ブートモード版ではシリアルフラッシュメモリ、16 ビットバスブートモード版では NOR
フラッシュメモリが格納領域となります。 

 
表 3.7 アプリケーションプログラムで使用するセクション 

セクション/ブロックの 
名前 

内容 格納/実行 
領域注 1 

PRG_RBLOCK コード領域(格納用) Flash 
USER_DATA_RBLOCK 変数領域(格納用) Flash 
PRG_WBLOCK コード領域(実行用) System SRAM 
USER_DATA_WBLOCK 初期値あり変数領域(実行用) System SRAM 
USER_DATA_ZBLOCK 初期値なし変数領域(実行用) System SRAM 

【注】 1. xSPI0 ブートモード版ではシリアルフラッシュメモリ、16 ビットバスブートモード版では NOR
フラッシュメモリが格納領域となります。 
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3.3.2.2 e2 studio 
表 3.8 にローダプログラムで使用するセクション、表 3.9 にアプリケーションプログラムで使用する

セクションを示します。これらのセクションはリンカスクリプトで定義されています。 
 

表 3.8 ローダプログラムで使用するセクション(e2 studio) 

セクション/ブロックの 
名前 

内容 格納/実行 
領域注 1 

.loader_param ローダパラメータ Flash 

.flash_contents コード領域(格納用) Flash 

.flash_contents 変数領域(格納用) Flash 

.text 

.intvec 

.reset_handler 

.loader_text 

コード領域(実行用) BTCM 

.data 

.rodata 
初期値あり変数領域(実行用) BTCM 

.bss 初期値なし変数領域(実行用) BTCM 

.IMAGE_APP_FLASH_section アプリケーションプログラム領域(格納用) Flash 

.IMAGE_APP_RAM アプリケーションプログラム領域(実行用) System SRAM 
【注】 1. xSPI0 ブートモード版ではシリアルフラッシュメモリ、16 ビットバスブートモード版では NOR

フラッシュメモリが格納領域となります。 
 

 
表 3.9 アプリケーションプログラムで使用するセクション(e2 studio) 

セクション/ブロックの 
名前 

内容 格納/実行 
領域注 1 

.flash_contents コード領域(格納用) Flash 

.flash_contents 変数領域(格納用) Flash 

.text 

.intvec 

.reset_handler 

.loader_text 

コード領域(実行用) System SRAM 

.data 

.rodata 
初期値あり変数領域(実行用) System SRAM 

.bss 初期値なし変数領域(実行用) System SRAM 
【注】 1. xSPI0 ブートモード版ではシリアルフラッシュメモリ、16 ビットバスブートモード版では NOR

フラッシュメモリが格納領域となります。 
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3.3.3 CPU MPU の設定 
本サンプルプログラムにおいて CPU がアクセスを行う領域の CPU MPU の設定を表 3.10 に示しま

す。アプリケーションプログラムのスタートアップ処理時に本設定が適用されます。 
 

表 3.10 CPU MPU の設定 

内容 アドレス メモリタイプ 
システム SRAM 0x1000_0000 

~ 
0x1017_FFFF 

領域 2 
ノーマル、キャッシュ可、非共有 

システム SRAM(ミラー領域) 0x3000_0000 
~ 

0x3017_FFFF 

領域 3 
ノーマル、キャッシュ不可、共有 

外部アドレス空間(ミラー領域) 
xSPI0, xSPI1 
CS0, CS2, CS3, CS5 

0x4000_0000 
~ 

0x5FFF_FFFF 

領域 4, 5, 6, 7, 8, 9 
ノーマル、キャッシュ不可、共有 

外部アドレス空間 
xSPI0, xSPI1 
CS0, CS2, CS3, CS5 

0x6000_0000 
~ 

0x7FFF_FFFF 

領域 10, 11, 12, 13, 14, 15 
ノーマル、キャッシュ可、非共有 

ノンセーフティ周辺モジュール 0x8000_0000 
~ 

0x80FF_FFFF 

領域 16 
デバイス(nGnRE)、命令フェッチ不可 

セーフティ周辺モジュール 0x8100_0000 
~ 

0x81FF_FFFF 

領域 17 
デバイス(nGnRE)、命令フェッチ不可 

 
 

3.3.4 例外処理ベクタテーブル 
RZ/N2L の Exception Level1 には 7 種類の例外処理(リセット、未定義命令、SVC、プリフェッチア

ボート、データアボート、IRQ、FIQ)があり、指定されたオフセット番地から 32 バイトの領域に配置さ

れます。例外処理ベクタテーブルには、各例外処理への分岐命令を記述します。 
表 3.11 に本サンプルプログラムにおける例外処理ベクタテーブルの内容を示します。必要に応じて

自由に変更してください。 
 

表 3.11 例外処理ベクタテーブル 

例外 ハンドラアドレス注 1 備考注 2 
RESET オフセット スタートアッププログラムに分岐 
未定義命令 オフセット + 0x0000_0004 Default_Handler へ分岐 
SVC オフセット + 0x0000_0008 Default_Handler へ分岐 
プリフェッチアボート オフセット + 0x0000_000C Default_Handler へ分岐 
データアボート オフセット + 0x0000_0010 Default_Handler へ分岐 
Reserved オフセット + 0x0000_0014 Default_Handler へ分岐 
IRQ オフセット + 0x0000_0018 IRQ_Handler へ分岐(割り込みで使用) 
FIQ オフセット + 0x0000_001C Default_Handler へ分岐 

【注】 1. 本サンプルプログラムのオフセットは下記のように設定されています。 
  ローダプログラム  : 0x0010_2000 
  アプリケーションプログラム : 0x1001_0000 
 2. Default_Handler ではソフトウェアブレーク命令が実行されます。 
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3.4 関数仕様 
サンプルプログラムの関数仕様を示します。 

3.4.1 system_init 
system_init 

概要 システム初期設定部 1 
宣言 void system_init (void) 
説明 Exception Level 2 から Exception Level 1 への移行、例外処理ベクタテーブルオフ

セットの設定などを行い、stack_init へ分岐します。 
引数 なし 

リターン値 なし 
補足 ブート処理終了後、スタートアップ処理で最初に実行される関数です。 

 
 

3.4.2 stack_init 
stack_init 

概要 システム初期設定部 2 
宣言 void stack_init (void) 
説明 スタックの設定、FPU の設定、クロック設定、スタートアップ処理に使用される変

数の初期化を行い、CPU MPU の設定、キャッシュの設定、ポートの設定などを行

い、main 処理へ分岐します。 
引数 なし 

リターン値 なし 
補足 なし 

 
 

3.4.3 hal_entry 
hal_entry 

概要 メイン処理 
宣言 void hal_entry (void) 
説明 • ローダプログラム : アプリケーションプログラムをローダテーブルの情報に

従って RAM へ展開します。プログラムのコピー開始前に LED0 が点灯し、コ

ピー完了後に LED3 が点灯します。 
• アプリケーションプログラム : System SRAM プログラムと SDRAM プログラ

ムをコールした後、ソフトウェア割り込み(INTCPU0)で LED3 が点滅します。 
引数 なし 

リターン値 なし 
補足 なし 
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3.4.4 bsp_sdram_init 
bsp_sdram_init 

概要 SDRAM 初期化処理 
宣言 void bsp_sdram_init (void) 
説明 SDRAM に関連したレジスタの初期設定を行います。 
引数 なし 

リターン値 なし 
補足 なし 

 
 

3.4.5 bsp_copy_multibyte 
bsp_copy_multibyte 

概要 コピー処理 
宣言 void bsp_copy_multibyte (uintptr_t *src,  uintptr_t *dst,  uintptr_t bytesize) 
説明 引数で指定したサイズ分 4byte 単位でデータのコピーを行います。 
引数 • uintptr_t *src : コピー元アドレス 

• uintptr_t *dst : コピー先アドレス 
• uintptr_t bytesize : コピーするデータサイズ  

リターン値 なし 
補足 なし 
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3.5 フローチャート 
3.5.1 ローダプログラム 
3.5.1.1 system_init 処理 

図 3.4 にローダプログラムの system_init 処理のフローチャートを示します。 
 

図 3.4  system_init 処理(ローダプログラム) 

 
  

system_init 

LLPP permission setting 

EL1 exception vector table offset 
setting 

stack_init 

Return from EL2 to EL1 

EL2 initialization Initialize in EL2. 

Set the offset of the exception vector table used 
in the loader program. 

Enable LLPP access. 

Save CPSR and move to EL1 with ERET instruction. 

Branch to stack_init. 
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3.5.1.2 stack_init 処理 

図 3.5 にローダプログラムの stack_init 処理のフローチャートを示します。 
 

図 3.5  stack_init 処理(ローダプログラム) 

 
  

stack_init 

Clock setting 

hal_entry 
 

Initialize variables used in the 
program 

Stack setting Set the stack pointer for each processor mode 
(System, FIQ, IRQ, Supervisor, Abort, Undefined). 

Set FPU operation permission. 

Set the clock. 

Initialize variables with initial values and 
clear variables without initial value used in the program. 

Update system core clock variable to the current CPU frequency value. 

FPU setting 

Update system core clock 
variable 

Initialize static constructor Initialize static constructor. 
This process is required for C++ projects. 

Port setting Set I/O port registers. 

Branch to hal_entry. 
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3.5.1.3 hal_entry 処理 

図 3.6 にローダプログラムの hal_entry 処理のフローチャートを示します。 
 

図 3.6  hal_entry 処理(ローダプログラム) 

 
  

Enable writing to registers related to I/O port. 

Turns on LED0 to signal the start of copy processing. 

Copy the application program to System SRAM 
from external flash memory 
according to the parameters of loader table. 

Turns on LED3 to signal the end of copy processing. 

Branch to application program. 

Disable writing to registers related to I/O port. 

Initialize registers related to SDRAM 

hal_entry 

app_prg 

Turn on LED3 

Disable port protection 

Turn on LED0 

Copy application program from 
external flash memory to RAM 

Enable port protection 

SDRAM setting 
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3.5.2 アプリケーションプログラム 
3.5.2.1 system_init 処理 

図 3.7 にアプリケーションプログラムの system_init 処理のフローチャートを示します。 
 

図 3.7  system_init 処理(アプリケーションプログラム) 

 
  

system_init 

EL1 exception vector table offset 
setting 

stack_init 

Set the offset of the exceptionvector table used 
in the application program. 

Branch to stack_init. 
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3.5.2.2 stack_init 処理 

図 3.8、図 3.9 にアプリケーションプログラムの stack_init 処理のフローチャートを示します。 
 

図 3.8  stack_init 処理(アプリケーションプログラム) 

 
  

stack_init 

Clock setting 

Initialize variables used in the 
program 

Stack setting Set the stack pointer for each processor mode 
(System, FIQ, IRQ, Supervisor, Abort, Undefined). 

Set FPU operation permission. 

Set the clock. 

Initialize variables with initial values and 
clear variables without initial value used in the program. 

Update system core clock variable to the current CPU frequency value. 

FPU setting 

Update system core clock 
variable 

CPU MPU, cache setting Configure CPU MPU and cache. 

Initialize static constructor Initialize static constructor. 
This process is required for C++ projects. 

Port setting Set I/O port registers. 
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図 3.9  stack_init 処理(2/2)(アプリケーションプログラム) 

 
  

main 

Configure semaphore function. 

Configure TFU. 

Semaphore setting 

Master MPU setting 

Interrupt setting 

Global system counter setting 

TFU setting 

Branch to main, then branch to hal_entry. 

Set Master MPU registers. 

Enable global system counter. 

Initialize interrupt controller. 
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3.5.2.3 hal_entry 処理 

図 3.10 にアプリケーションプログラムの hal_entry 処理のフローチャートを示します。 
 

図 3.10  hal_entry 処理(アプリケーションプログラム) 

 
  

hal_entry 

Software delay 

Software interrupt setting Configure software interrupt (INTCPU0). 

Generate software interrupt (INTCPU0). 
After generating software interrupt, 
intcpu0_handler processing is executed. 

Delay by software. 

Generate software interrupt 
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図 3.11 にアプリケーションプログラムの割り込み処理のフローチャートを示します。 
 

図 3.11  割り込み処理(アプリケーションプログラム) 

 
  

intcpu0_handler 

return 

Disable port protection Enable writing to registers related to I/O port. 

Blink LED. 
If LED is on, turn off LED. 
If LED is off, turn on LED. 

Return to application main processing. 

Turn on/off LED3 

Enable port protection Disable writing to registers related to I/O port. 
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4. 参考ドキュメント 
• ユーザーズマニュアル : ハードウェア 

RZ/N2L グループ ユーザーズマニュアル ハードウェア編 
(最新版をルネサスエレクトロニクスホームページから入手してください。) 
 
Renesas Starter Kit+ for RZ/N2L ユーザーズマニュアル 
(最新版をルネサスエレクトロニクスホームページから入手してください。) 
 
 

• テクニカルアップデート / テクニカルニュース 
(最新版をルネサスエレクトロニクスホームページから入手してください。) 
 
 

• ユーザーズマニュアル : 開発環境 
IAR 統合開発環境(IAR Embedded Workbench® for Arm)に関しては、最新版を IAR システムズ社ホーム

ページから入手してください。 
ルネサスエレクトロニクス統合開発環境(e2 studio)に関しては、最新版をルネサスエレクトロニクスホー

ムページから入手してください。 
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5. 付録. 各開発環境における補足内容 
ここでは、本サンプルプログラムを本開発環境で使用する際のデバッグまでの手順を説明します。xSPI0

ブートモード版を使用した例を示します。 

5.1 サンプルプログラムのデバッグ手順 
5.1.1 EWARM : IAR システムズ社製 
1. EWARM を起動し、[ファイル] -> [開く] -> [ワークスペース]で

Loader_application_projects¥RZN2L_bsp_ xspi0bootx1_separating_loader.eww を指定し、サンプル

プロジェクトを開きます。このワークスペースにはローダプロジェクトとアプリケーションプロジェ

クトが含まれています。 
2. RZN2L_bsp_xspi0bootx1_app Debug のプロジェクトをワークスペースから選択します。 

図 5.1 プロジェクト選択 

 

3. [ツール]から FSP Configurator を開き、[Generate Project Content]ボタンを押してコード生成を実行

します。コード生成が完了したら FSP Configurator を閉じます。 

図 5.2  FSP Configurator の起動 

 
※ [Tools]→[Configure Tools…]を開き、使用する FSP を事前に登録しておく必要があります。 
 

表 5.1  FSP Smart Configurator の登録例 

設定項目 設定例 

Menu Text FSP Smart Configurator 
Command C:¥Renesas¥rzn¥sc_v2025-4.1_fsp_v3.0.0¥eclipse¥rasc.exe 
Argument --compiler IAR configuration.xml 
Initial Directory $PROJ_DIR$ 
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4. [プロジェクト]→[オプション]を開き、[リンカ]カテゴリを開きます。使用するリンカスクリプトを

『 $PROJ_DIR$/script/fsp_xspi0_boot_app.icf 』に設定します。 

図 5.3 リンカスクリプトの設定(アプリケーションプログラム) 

 

5. [プロジェクト]→[全てを再ビルド]を押し、アプリケーションプログラムのビルドを実行します。 
6. RZN2L_bsp_xspi0bootx1_loader Debug プロジェクトをワークスペースから選択して開きます。 
7. [ツール]から FSP Configurator を開き、[Generate Project Content]ボタンを押してコード生成を実行

します。コード生成が完了したら FSP Configurator を閉じます。 
8. [プロジェクト]→[オプション]を開き、[リンカ]カテゴリを開きます。使用するリンカスクリプトを

『 $PROJ_DIR$/script/fsp_xspi0_boot_loader.icf 』に設定します。 

図 5.4 リンカスクリプトの設定(ローダプログラム) 

 

9. [プロジェクト]→[全てを再ビルド]を押し、ローダプログラムのビルドを実行します。 
10. RZN2L_bsp_xspi0bootx1_loader Debug プロジェクトをワークスペースから選択し、RZ/N2L 評価

ボードと I-jet を接続した状態で、[プロジェクト]->[ダウンロードしてデバッグ]を選択します。 
11. エミュレータ接続後、専用フラッシュダウンローダにより外付けシリアルフラッシュメモリへプログ

ラムの書き込みが行われた後に、デバッグが開始されます。この時、ローダプログラムとアプリケー

ションプログラムが同時に外付けシリアルフラッシュメモリへ書き込まれます。 
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EWARM 環境における補足事項① 
デバッグで動作を確認する際、ローダプログラムのプロジェクトを選択してデバッグを行ってくださ

い。下記のオプション設定により、ローダプロジェクトでデバッグ接続時にローダプログラムとアプ

リケーションプログラムが同時に外付けシリアルフラッシュメモリへ書き込まれます。 
 
Path: 

$PROJ_DIR$¥..¥RZN2L_bsp_xspi0bootx1_app¥Debug¥Exe¥RZN2L_bsp_xspi0bootx1_app.out 
 

図 5.5  EWARM オプション設定 
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EWARM 環境における補足事項② 
ローダプログラムのビルド時、下記のオプション設定によりアプリケーションプログラムと一緒に

ローダプログラムがビルドされます。 
 
Keep symbols: 

APPLICATION_PRG_SECTION 
File: 

$PROJ_DIR$¥..¥RZN2L_bsp_xspi0bootx1_app¥Debug¥Exe¥RZN2L_bsp_xspi0bootx1_app.bin 
 Symbol: 
   APPLICATION_PRG_SECTION 
 Section: 
   APPLICATION_PRG_SECTION 
 Align: 
   4 

 

図 5.6  EWARM オプション設定② 
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EWARM 環境における補足事項③ 
以下のオプション設定により、アプリケーションプロジェクトのビルド時にローバイナリでビルド

成果物が出力されます。 
 
1. [Project]→[Options]を開きます。 
2. [Output Converter]を開き、[Output format]を"Raw binary"に変更します。 

 

 
  

図 5-7 アプリケーションプロジェクトの出力フォーマットの設定 



RZ/N2L グループ ローダプログラムとアプリケーションプログラムのプロジェクト分割例 

R01AN6737JJ0301  Rev.3.01  Page 33 of 47 
2026.4.1  

EWARM 環境における補足事項④ 
以下のオプション設定により、ローダプロジェクトとアプリケーションプロジェクトのコンパイル

前に設定されているコード生成用アクションを削除しています。 
このアクションはコンパイル前にコード生成を行う機能であり、コード生成の実行によりリンカス

クリプトファイルのパスがデフォルト設定に上書きされてしまうため、本設定によりこれを防止し

ています。 
 
1. [Project]→[Options]を開きます。 
2. [Build Actions]を開き、[Build order]が"Pre-compile"のものを選択して、[Remove]をクリックし

ます。 
 

 
  

図 5-8 ビルドアクションの消去 
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EWARM 環境における補足事項⑤ 
ローダプロジェクトとアプリケーションプロジェクトのデバッグ設定を以下のように変更していま

す。 
 
[ローダプロジェクト] 
1. [Project]→[Options]を開きます。 
2. [Debugger]→[Setup]を開き、"Run to"のチェックを外します。 
3. [I-jet]→[Setup]を開き、"From the probe"のチェックを外します。 

 

 

 
  

図 5-9 ローダプロジェクトのデバッグ設定① 

図 5-10 ローダプロジェクトのデバッグ設定② 
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[アプリケーションプロジェクト] 
1. [Project]→[Options]を開きます。 
2. [Debugger]→[Setup]を開き、"Run to"のチェックを外します。 
3. [I-jet]→[Setup]を開き、"From the probe"のチェックを外し、[Reset]を"Software"に変更しま

す。 
 

 

 
  

図 5-11 アプリケーションプロジェクトのデバッグ設定① 

図 5-12 アプリケーションプロジェクトのデバッグ設定② 
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EWARM 環境における補足事項⑥ 
 デバッグ開始時、次のスタック plug-in に関する警告が表示される場合があります。 
 

図 5-13 スタック plug-in に関する警告 

 
 [ツール]→[オプション]→[Stack]を選択し、[Stack pointer(s) not valid until program reaches]の
チェックマークを外すことで、上記の警告ウィンドウは表示されなくなります。 

図 5-14  IDE Options の設定 
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5.1.2 e2 studio : Renesas 社製 
1. e2 studio を起動しワークスペースへ移動後、[ファイル] -> [インポート]をクリックし、一般 -> 既存

プロジェクトをワークスペースへ を選択して[次へ]をクリックします。 
2. プロジェクトのインポート画面でアーカイブ・ファイルの選択にて Loader_application_projects.zip を

指定して[終了]をクリックします。 
3. “RZN2L_bsp_xspi0bootx1_app”プロジェクトの configuration.xml を開き、[Generate Project Content]

ボタンを押してコード生成を実行します。 
4. “RZN2L_bsp_xspi0bootx1_app”プロジェクトのクリーンを実行した後に、ビルドを実行します。 
5. “RZN2L_bsp_xspi0bootx1_loader”プロジェクトの configuration.xml を開き、[Generate Project 

Content]ボタンを押してコード生成を実行します。 
6. “RZN2L_bsp_xspi0bootx1_loader”プロジェクトのクリーンを実行した後に、ビルドを実行します。 
7. “RZN2L_bsp_xspi0bootx1_loader”プロジェクトのデバッグ接続設定を選択し、RZ/N2L 評価ボードと

J-Link を接続した状態で、[デバッグ]を選択しデバッグを開始します。 
8. エミュレータ接続後、専用フラッシュダウンローダにより外付けシリアルフラッシュメモリへプログ

ラムの書き込みが行われた後に、デバッグが開始されます。この時、ローダプログラムとアプリケー

ションプログラムが同時に外付けシリアルフラッシュメモリへ書き込まれます。 
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e2 studio 環境における補足事項① 
以下のオプション設定により、ローダプロジェクトとアプリケーションプロジェクトのリンカスク

リプトファイルのパスを変更しています。 
 

1. プロジェクトのノードを右クリックし、[Properties]を開きます。 
2. [C/C++ Build]→[Settings]→[Tool Settings]→[Cross ARM C Linker]→[General]を開き、ファイル

パスを変更します。 
[ローダプロジェクト]  ：”fsp_xspi0_boot_loader.ld” 
[アプリケーションプロジェクト] ：”fsp_xspi0_boot_app.ld” 

 

 
  

図 5-16 ローダプロジェクトのリンカスクリプトファイルパスの設定 

図 5-15 アプリケーションプロジェクトのリンカスクリプトファイルパスの設定 
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e2 studio 環境における補足事項② 
以下のオプション設定により、アプリケーションプロジェクトのビルド時にローバイナリでビルド

成果物が出力されます。 
 

1. アプリケーションプロジェクトのノードを右クリックし、[Properties]を開きます。 
2. [C/C++ Build]→[Settings]→[Tool Settings]→[Cross ARM GNU Create Flash Image]→[General]

を開き、[Output file format (-O)]を"Raw binary"に変更します。 
 

 
  

図 5-17 アプリケーションプロジェクトの出力フォーマットの設定 
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e2 studio 環境における補足事項③ 
デバッグで動作を確認する際、ローダプログラムのプロジェクトを選択してデバッグを行ってくださ

い。下記のデバッグ接続設定により、ローダプロジェクトでデバッグ接続時にローダプログラムとア

プリケーションプログラムが同時に外付けシリアルフラッシュメモリへ書き込まれます。 

図 5-18  e2 studio デバッグ接続設定 
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5.1.3 アプリケーションプログラムとローダプログラムの補足事項 
補足事項① 

以下の FSP 設定により、アプリケーションプロジェクトの C ランタイムを無効化しています。 
アプリケーションプロジェクトの C ランタイム初期化はローダプロジェクトで行われています。 

 
1. アプリケーションプロジェクトの configuration.xml を開きます。 
2. [BSP]→[C Runtime Initialization]を"Disabled"に変更します。 

 

 

  
図 5-19 アプリケーションプログラムの BSP 設定 
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補足事項② 
以下の FSP 設定により、アプリケーションプロジェクトの "INTCPU0" 割り込みを設定していま

す。 
 

1. アプリケーションプロジェクトの configuration.xml を開きます。 
2. [Interrupts]→[New User Event]→[ICU]→[INTCPU0 (Software interrupt 0)]を選択し、

"intcpu0_handler"を設定し、[OK]をクリックします。 
 

 

 
  

図 5-20 アプリケーションプログラムの割り込み設定① 

図 5-21 アプリケーションプログラムの割り込み設定② 
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補足事項③ 
アプリケーションプログラムとローダプログラムの startup_core.c は、FSP コンフィグレータに

よって生成されたものから下記の修正を加えています。本サンプルパッケージには、修正を加えた

startup_core.c がコード生成前から含まれています。FSP バージョンを変更した場合は、コード生

成したものに上書きされてしまうため、同様の修正を加えて下さい。 
 

図 5-22 startup_core.c の修正(ローダプログラム) 

図 5-23 startup_core.c の修正(アプリケーションプログラム) 

  

BSP_TARGET_ARM BSP_ATTRIBUTE_STACKLESS void system_init (void) 
{ 
#if 1 // Software loops are only needed when debugging. 
    __asm volatile ( 
        "   mov   r0, #0                          ¥n" 
        "   movw  r1, #0x68bf                     ¥n" 
        "   movt  r1, #0x478                      ¥n" 
        "software_loop:                           ¥n" 
        "   adds  r0, #1                          ¥n" 
        "   cmp   r0, r1                          ¥n" 
        "   bne   software_loop                   ¥n" 
        ::: "memory"); 
#endif 
 
    __asm volatile ( 
        "set_hactlr:                              ¥n" 
        "    MOVW  r0, %[bsp_hactlr_bit_l]        ¥n" /* Set HACTLR bits(L) */ 
        "    MOVT  r0, #0                         ¥n" 
        "    MCR   p15, #4, r0, c1, c0, #1        ¥n" /* Write r0 to HACTLR */ 
        ::[bsp_hactlr_bit_l] "i" (BSP_HACTLR_BIT_L) : "memory"); 

BSP_TARGET_ARM BSP_ATTRIBUTE_STACKLESS void system_init (void) 
{ 
/* These settings are invalid for application project. 
 * The necessary processing has been performed in the loader program. */ 
#if 0 // Original program 
    __asm volatile ( 
        "set_hactlr:                              ¥n" 
        "    MOVW  r0, %[bsp_hactlr_bit_l]        ¥n" /* Set HACTLR bits(L) */ 
        "    MOVT  r0, #0                         ¥n" 
        "    MCR   p15, #4, r0, c1, c0, #1        ¥n" /* Write r0 to HACTLR */ 
        ::[bsp_hactlr_bit_l] "i" (BSP_HACTLR_BIT_L) : "memory"); 
 
~~~ omission ~~~ 
 
    __asm volatile ( 
        "exception_return:                        ¥n" 
        "    LDR   r1, =stack_init                ¥n" 
        "    MSR   ELR_hyp, r1                    ¥n" 
        "    ERET                                 ¥n" /* Branch to stack_init and enter EL1 */ 
        ::: "memory"); 
 
#else 
    /* Set exception vector offset for application program. */ 
    __asm volatile ( 
        "set_vbar:                                ¥n" 
        "    LDR   r0, =__Vectors                 ¥n" 
        "    MCR   p15, #0, r0, c12, c0, #0       ¥n" /* Write r0 to VBAR */ 
        ::: "memory"); 
 
    __asm volatile ( 
        "jump_stack_init:                         ¥n" 
        "    LDR   r0, =stack_init                ¥n" 
        "    BLX   r0                             ¥n" 
        ::: "memory"); 
#endif 
} 
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5.2 アプリケーションプログラムの RAM 配置の変更例 
本サンプルプログラムはローダテーブルで指定されたコピー元アドレスからコピー先アドレスへアプ

リケーションプログラムのコピーを行います。ユーザは必要に応じてコピー元アドレスとコピー先アド

レスを書き換えることでアプリケーションプログラムの配置を変更することが可能です。 
 

5.2.1 EWARM : IAR システムズ社製 
下記にアプリケーションプログラムの配置を System SRAM から ATCM に変更する例(xspi0boot のプ

ロジェクト)を示します。 
 

fsp_xspi0_boot_loader.icf (ローダプログラムのリンカスクリプト) 

Default 
~~~ 
/* Internal memory */ 
define region BTCM_LDR_region  =   mem:[from 0x00102000 size  56K]; 
define region APPLICATION_RAM_region  =  mem:[from 0x10010000 size 128K]; 
 
/* Flash memory */ 
define region LOADER_TABLE_region  =  mem:[from 0x60080000 size 64K]; 
define region APPLICATION_ROM_region  =  mem:[from 0x60100000 size 1M]; 
~~~ 
 
After changing 
~~~ 
/* Internal memory */ 
define region BTCM_LDR_region  =   mem:[from 0x00102000 size  56K]; 
define region APPLICATION_RAM_region  =  mem:[from 0x00000000 size 128K]; /* Change copy destination 

address to ATCM */ 
 
/* Flash memory */ 
define region LOADER_TABLE_region  =  mem:[from 0x60080000 size 64K]; 
define region APPLICATION_ROM_region  =  mem:[from 0x60100000 size 1M]; 
~~~ 
 

 

fsp_xspi0_boot_app.icf (アプリケーションプログラムのリンカスクリプト) 

Default 
~~~ 
place at start of SYSTEM_RAM_PRG_region  { block PRG_WBLOCK }; 
place in SYSTEM_RAM_PRG_region           { block USER_DATA_WBLOCK }; 
place in SYSTEM_RAM_PRG_region           { block USER_DATA_ZBLOCK }; 
place in SYSTEM_RAM_PRG_region           { rw data, 
                                              rw section .sys_stack, 
                                              rw section .svc_stack, 
                                              rw section .irq_stack, 
                                              rw section .fiq_stack, 
                                              rw section .und_stack, 
                                              rw section .abt_stack }; 
place in SYSTEM_RAM_region              { rw section HEAP }; 
~~~ 
 
After changing 
~~~ 
place at start of ATCM_region  { block PRG_WBLOCK };           /* Change code area to ATCM */ 
place in ATCM_region            { block USER_DATA_WBLOCK };    /* Change data area to ATCM */ 
place in ATCM_region            { block USER_DATA_ZBLOCK };    /* Change bss area to ATCM */ 
place in ATCM_region            { rw data,                       /* Change stack area to ATCM */ 
                                    rw section .sys_stack, 
                                    rw section .svc_stack, 
                                    rw section .irq_stack, 
                                    rw section .fiq_stack, 
                                    rw section .und_stack, 
                                    rw section .abt_stack }; 
place in ATCM_region            { rw section HEAP };    /* Change HEAP area to ATCM */ 
~~~ 
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5.2.2 e2 studio : Renesas 社製 
下記にアプリケーションプログラムの配置を System SRAM から ATCM に変更する例(xspi0boot のプ

ロジェクト)を示します。 
 

fsp_xspi0_boot_loader.ld (ローダプログラムのリンカスクリプト) 

Default 
~~~ 
.IMAGE_APP_RAM 0x10010000 : AT (0x10010000) 
{ 

IMAGE_APP_RAM_start = .; 
KEEP(*(APP_IMAGE_RAM)) 

} > SYSTEM_RAM 
.IMAGE_APP_FLASH_section 0x60100000 : AT (0x60100000) 
{ 

IMAGE_APP_FLASH_section_start = .; 
KEEP(./src/Flash_section.o(.IMAGE_APP_FLASH_section)) 
IMAGE_APP_FLASH_section_end = .; 

} > FLASH_CONTENTS 
~~~ 
 
After changing 
~~~ 
.IMAGE_APP_RAM 0x00000000 : AT (0x00000000) /* Change copy destination address to ATCM */ 
{ 

IMAGE_APP_RAM_start = .; 
KEEP(*(APP_IMAGE_RAM)) 

} > SYSTEM_RAM 
.IMAGE_APP_FLASH_section 0x60100000 : AT (0x60100000) 
{ 

IMAGE_APP_FLASH_section_start = .; 
KEEP(./src/Flash_section.o(.IMAGE_APP_FLASH_section)) 
IMAGE_APP_FLASH_section_end = .; 

} > FLASH_CONTENTS 
~~~ 
 

 

fsp_xspi0_boot_app.ld (アプリケーションプログラムのリンカスクリプト) 

Default 
~~~ 
.text 0x10010000 : AT (TEXT_IMAGE) 
{ 

~~~ 
    _text_end = .; 
} > SYSTEM_RAM 

 
~~~ 
__extab_end = .; 

} > SYSTEM_RAM 
 

    ~~~ 
    __exidx_end = .; 
} > SYSTEM_RAM 

 
    ~~~ 
    _data_end = .; 
} > SYSTEM_RAM 

 
    ~~~ 
    _end = .; 
} > SYSTEM_RAM 

 
    ~~~ 
    __HeapLimit = .; 
} > SYSTEM_RAM 

 
    ~~~ 
    __AArch64StackLimit = .; 
} > SYSTEM_RAM 

 
   ~~~ 
    __ThreadStackLimit = .; 
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} > SYSTEM_RAM 
 

    ~~~ 
    __AbtStackLimit = .; 
} > SYSTEM_RAM 

 
~~~ 
 
After Changing 
~~~ 
.text 0x00000000 : AT (TEXT_IMAGE) /* Change code area to ATCM */ 
{ 

~~~ 
    _text_end = .; 
} > ATCM 

 
~~~ 
__extab_end = .; 

} > ATCM 
 

    ~~~ 
    __exidx_end = .; 
} > ATCM 

 
    ~~~ 
    _data_end = .; 
} > ATCM 

 
    ~~~ 
    _end = .; 
} > ATCM 

 
    ~~~ 
    __HeapLimit = .; 
} > ATCM 

 
    ~~~ 
    __AArch64StackLimit = .; 
} > ATCM 

 
    ~~~ 
    __ThreadStackLimit = .; 
} > ATCM 

 
    ~~~ 
    __AbtStackLimit = .; 
} > ATCM 

 
~~~ 
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改訂記録 

Rev. 発行日 
改訂内容 

ページ ポイント 
1.00 2022.12.09 - 初版 
1.10 2023.05.31 - ローダプログラム、アプリケーションプログラムの動作を修

正 
4 RZ/N2L FSP の対応バージョン変更 v1.0.0 -> v1.1.0 

32 RAM 配置の変更例を追加 
2.00 2024.09.13 4 RZ/N2L FSP の対応バージョン変更 v1.1.0 -> v2.0.0 

統合開発環境のバージョン変更 
- mpu_cache_init の関数を削除 

17 bsp_copy_4byte から bsp_copy_multibyte に変更 
30 fsp_xspi0_boot_loader.icf の内容修正 

2.10 2025.05.16 14, 31 DATA_RBLOCK から USER_DATA_RBLOCK に変更

DATA_WBLOCK から USER_DATA_WBLOCK に変更

DATA_ZBLOCK から USER_DATA_ZBLOCK に変更 
32, 35 BTCM にデータセクションとスタックを配置する説明の消去 

3.00 2025.12.22 - FSP v3.00 対応 
3.01 2026.4.1 32 ~ 35 サンプルプログラムの EWARM 環境における補足事項の追記 

37 e2 studio 環境のデバッグ手順の変更 
38, 39 サンプルプログラムの e2 studio 環境における補足事項の追記 
41, 42 サンプルプログラムのアプリケーションプログラムとローダ

プログラムの補足事項の追記 
 

 



 

 

製品ご使用上の注意事項 
ここでは、マイコン製品全体に適用する「使用上の注意事項」について説明します。個別の使用上の注意事項については、本ドキュメントおよびテク

ニカルアップデートを参照してください。 

1. 静電気対策 

CMOS 製品の取り扱いの際は静電気防止を心がけてください。CMOS 製品は強い静電気によってゲート絶縁破壊を生じることがあります。運搬や保

存の際には、当社が出荷梱包に使用している導電性のトレーやマガジンケース、導電性の緩衝材、金属ケースなどを利用し、組み立て工程にはアー

スを施してください。プラスチック板上に放置したり、端子を触ったりしないでください。また、CMOS 製品を実装したボードについても同様の扱

いをしてください。 

2. 電源投入時の処置 

電源投入時は、製品の状態は不定です。電源投入時には、LSI の内部回路の状態は不確定であり、レジスタの設定や各端子の状態は不定です。外部

リセット端子でリセットする製品の場合、電源投入からリセットが有効になるまでの期間、端子の状態は保証できません。同様に、内蔵パワーオン

リセット機能を使用してリセットする製品の場合、電源投入からリセットのかかる一定電圧に達するまでの期間、端子の状態は保証できません。 

3. 電源オフ時における入力信号 

当該製品の電源がオフ状態のときに、入力信号や入出力プルアップ電源を入れないでください。入力信号や入出力プルアップ電源からの電流注入に

より、誤動作を引き起こしたり、異常電流が流れ内部素子を劣化させたりする場合があります。資料中に「電源オフ時における入力信号」について

の記載のある製品は、その内容を守ってください。 

4. 未使用端子の処理 

未使用端子は、「未使用端子の処理」に従って処理してください。CMOS 製品の入力端子のインピーダンスは、一般に、ハイインピーダンスとなっ

ています。未使用端子を開放状態で動作させると、誘導現象により、LSI 周辺のノイズが印加され、LSI 内部で貫通電流が流れたり、入力信号と認識

されて誤動作を起こす恐れがあります。 

5. クロックについて 

リセット時は、クロックが安定した後、リセットを解除してください。プログラム実行中のクロック切り替え時は、切り替え先クロックが安定した

後に切り替えてください。リセット時、外部発振子（または外部発振回路）を用いたクロックで動作を開始するシステムでは、クロックが十分安定

した後、リセットを解除してください。また、プログラムの途中で外部発振子（または外部発振回路）を用いたクロックに切り替える場合は、切り

替え先のクロックが十分安定してから切り替えてください。 

6. 入力端子の印加波形 

入力ノイズや反射波による波形歪みは誤動作の原因になりますので注意してください。CMOS 製品の入力がノイズなどに起因して、VIL（Max.）か

ら VIH（Min.）までの領域にとどまるような場合は、誤動作を引き起こす恐れがあります。入力レベルが固定の場合はもちろん、VIL（Max.）から VIH

（Min.）までの領域を通過する遷移期間中にチャタリングノイズなどが入らないように使用してください。 

7. リザーブアドレス（予約領域）のアクセス禁止 

リザーブアドレス（予約領域）のアクセスを禁止します。アドレス領域には、将来の拡張機能用に割り付けられている リザーブアドレス（予約領

域）があります。これらのアドレスをアクセスしたときの動作については、保証できませんので、アクセスしないようにしてください。 

8. 製品間の相違について 

型名の異なる製品に変更する場合は、製品型名ごとにシステム評価試験を実施してください。同じグループのマイコンでも型名が違うと、フラッ

シュメモリ、レイアウトパターンの相違などにより、電気的特性の範囲で、特性値、動作マージン、ノイズ耐量、ノイズ幅射量などが異なる場合が

あります。型名が違う製品に変更する場合は、個々の製品ごとにシステム評価試験を実施してください。 
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ご注意書き 
1. 本資料に記載された回路、ソフトウェアおよびこれらに関連する情報は、半導体製品の動作例、応用例を説明するものです。回路、ソフトウェアお

よびこれらに関連する情報を使用する場合、お客様の責任において、お客様の機器・システムを設計ください。これらの使用に起因して生じた損害

（お客様または第三者いずれに生じた損害も含みます。以下同じです。）に関し、当社は、一切その責任を負いません。 
2. 当社製品または本資料に記載された製品デ－タ、図、表、プログラム、アルゴリズム、応用回路例等の情報の使用に起因して発生した第三者の特許

権、著作権その他の知的財産権に対する侵害またはこれらに関する紛争について、当社は、何らの保証を行うものではなく、また責任を負うもので

はありません。 
3. 当社は、本資料に基づき当社または第三者の特許権、著作権その他の知的財産権を何ら許諾するものではありません。 
4. 当社製品を組み込んだ製品の輸出入、製造、販売、利用、配布その他の行為を行うにあたり、第三者保有の技術の利用に関するライセンスが必要と

なる場合、当該ライセンス取得の判断および取得はお客様の責任において行ってください。 
5. 当社製品を、全部または一部を問わず、改造、改変、複製、リバースエンジニアリング、その他、不適切に使用しないでください。かかる改造、改

変、複製、リバースエンジニアリング等により生じた損害に関し、当社は、一切その責任を負いません。 
6. 当社は、当社製品の品質水準を「標準水準」および「高品質水準」に分類しており、各品質水準は、以下に示す用途に製品が使用されることを意図

しております。 
 標準水準： コンピュータ、OA 機器、通信機器、計測機器、AV 機器、家電、工作機械、パーソナル機器、産業用ロボット等 
 高品質水準： 輸送機器（自動車、電車、船舶等）、交通制御（信号）、大規模通信機器、金融端末基幹システム、各種安全制御装置等 
当社製品は、データシート等により高信頼性、Harsh environment 向け製品と定義しているものを除き、直接生命・身体に危害を及ぼす可能性のあ

る機器・システム（生命維持装置、人体に埋め込み使用するもの等）、もしくは多大な物的損害を発生させるおそれのある機器・システム（宇宙機

器と、海底中継器、原子力制御システム、航空機制御システム、プラント基幹システム、軍事機器等）に使用されることを意図しておらず、これら

の用途に使用することは想定していません。たとえ、当社が想定していない用途に当社製品を使用したことにより損害が生じても、当社は一切その

責任を負いません。 
7. あらゆる半導体製品は、外部攻撃からの安全性を 100％保証されているわけではありません。当社ハードウェア／ソフトウェア製品にはセキュリ

ティ対策が組み込まれているものもありますが、これによって、当社は、セキュリティ脆弱性または侵害（当社製品または当社製品が使用されてい

るシステムに対する不正アクセス・不正使用を含みますが、これに限りません。）から生じる責任を負うものではありません。当社は、当社製品ま

たは当社製品が使用されたあらゆるシステムが、不正な改変、攻撃、ウイルス、干渉、ハッキング、データの破壊または窃盗その他の不正な侵入行

為（「脆弱性問題」といいます。）によって影響を受けないことを保証しません。当社は、脆弱性問題に起因しまたはこれに関連して生じた損害に

ついて、一切責任を負いません。また、法令において認められる限りにおいて、本資料および当社ハードウェア／ソフトウェア製品について、商品

性および特定目的との合致に関する保証ならびに第三者の権利を侵害しないことの保証を含め、明示または黙示のいかなる保証も行いません。 
8. 当社製品をご使用の際は、最新の製品情報（データシート、ユーザーズマニュアル、アプリケーションノート、信頼性ハンドブックに記載の「半導

体デバイスの使用上の一般的な注意事項」等）をご確認の上、当社が指定する最大定格、動作電源電圧範囲、放熱特性、実装条件その他指定条件の

範囲内でご使用ください。指定条件の範囲を超えて当社製品をご使用された場合の故障、誤動作の不具合および事故につきましては、当社は、一切

その責任を負いません。 
9. 当社は、当社製品の品質および信頼性の向上に努めていますが、半導体製品はある確率で故障が発生したり、使用条件によっては誤動作したりする

場合があります。また、当社製品は、データシート等において高信頼性、Harsh environment 向け製品と定義しているものを除き、耐放射線設計を

行っておりません。仮に当社製品の故障または誤動作が生じた場合であっても、人身事故、火災事故その他社会的損害等を生じさせないよう、お客

様の責任において、冗長設計、延焼対策設計、誤動作防止設計等の安全設計およびエージング処理等、お客様の機器・システムとしての出荷保証を

行ってください。特に、マイコンソフトウェアは、単独での検証は困難なため、お客様の機器・システムとしての安全検証をお客様の責任で行って

ください。 
10. 当社製品の環境適合性等の詳細につきましては、製品個別に必ず当社営業窓口までお問合せください。ご使用に際しては、特定の物質の含有・使用

を規制する RoHS 指令等、適用される環境関連法令を十分調査のうえ、かかる法令に適合するようご使用ください。かかる法令を遵守しないことに

より生じた損害に関して、当社は、一切その責任を負いません。 
11. 当社製品および技術を国内外の法令および規則により製造・使用・販売を禁止されている機器・システムに使用することはできません。当社製品お

よび技術を輸出、販売または移転等する場合は、「外国為替及び外国貿易法」その他日本国および適用される外国の輸出管理関連法規を遵守し、そ

れらの定めるところに従い必要な手続きを行ってください。 
12. お客様が当社製品を第三者に転売等される場合には、事前に当該第三者に対して、本ご注意書き記載の諸条件を通知する責任を負うものといたしま

す。 
13. 本資料の全部または一部を当社の文書による事前の承諾を得ることなく転載または複製することを禁じます。 
14. 本資料に記載されている内容または当社製品についてご不明な点がございましたら、当社の営業担当者までお問合せください。 
注 1. 本資料において使用されている「当社」とは、ルネサス エレクトロニクス株式会社およびルネサス エレクトロニクス株式会社が直接的、間接的

に支配する会社をいいます。 
注 2. 本資料において使用されている「当社製品」とは、注１において定義された当社の開発、製造製品をいいます。 
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本社所在地  お問合せ窓口 
〒135-0061 東京都江東区豊洲 3-2-24（豊洲フォレシア） 

www.renesas.com 

 弊社の製品や技術、ドキュメントの最新情報、最寄の営業お問合せ窓

口に関する情報などは、弊社ウェブサイトをご覧ください。 

www.renesas.com/contact/ 

商標について   

ルネサスおよびルネサスロゴはルネサス エレクトロニクス株式会社の

商標です。すべての商標および登録商標は、それぞれの所有者に帰属

します。 
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